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WXT536 WEATHER TRANSMITTER 
운영자매뉴얼 Rev.17.7

1. Communication Protocol

1.1 Serial Communication Setting
Maintenance Port
- Baud rate : 19200
- Data bit : 8
- Parity : None
- Stop bit : 1
- Flow control : None
RS-485 Serial Communication(ASCII format) 
- Baud rate : 19200
- Data bit : 8
- Parity : None
- Stop bit : 1
- Flow control : None
데이터 전송주기: 3sec 주기로 데이터 자동전송
 
WXT536 컨트롤박스의 Maintenance 포트에 RS485컨버터를 연결 후 하이퍼 
터미널을 이용하여 데이터 확인 및 점검을 진행한다. 

1.2 Communication Stting Commands
WXT536은 명령어를 이용하여 센서의 수집주기, 통신 방식, 메시지 타입 등 
설정을 할 수 있으며, 설정 시에는 유지보수 케이블을 이용하여 Vaisala 
Configuration Tool을 통해 사용자의 요구 사항에 맞게 설정이 가능 하다. 
WXT536의 설정은 유지보수 포트를 이용하여 변경하는 것을 권장한다.

     
     1.2.5 Precipitation Counter Reset - 강수량 누적값 초기화 명령어
     1.2.6 Precipitation Intensity Reset - 강우강도 초기화 명령어
     1.2.5 WXT520 Software Reset - 리셋 명령어(원격접속)

1.2.1 Setting Fields
통신설정 확인 방법

ex) ASCII 통신체제: aXU<cr><lf>
a           = Device address: 0(default) ~ 9, A ~ Z, a ~ z
XU          = 장비 셋팅 명령어(ASCII, NMEA 0183)
<cr><lf>    = 명령어 종료시(ASCII, NMEA 0183)
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Example response in ASCII, NMEA 0183:
aXU,A=a,M=[M],T=[T],C=[C],B=[B],D=[D],P=[P],S=[S],L=[L],N=[N],V=[V]
<cr><lf> 

aXU를 이용하여 WXT536의 현재 설정값을 확인 할 수 있으며, 설정 사항에 
대한 상세 항목은 표 1.2.1을 참고 한다.
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a = Device address

XU = Device settings commands in ASCII, NMEA 0183

XXU = Device settings commands in SDI-12

[A] = Address: 0(default) ~ 9, A ~ Z, a ~ z

[M] = Communication protocol

  A = ASCII, automatic

  a = ASCII, automatic with CRC

  P = ASCII, polled

  p = ASCII, polled with CRC

  N = NEMA 0183 v3.0, automatic

  Q = NEMA 0183 v3.0, query (=polled)

  S = SDI-12 v1.3

  s = SDI-12 v1.3 continuous measuremesnt

[T] = Test parameter(for testing use only)

[C] = Serial interface: 1 = SDI-12

                  2 = RS-232

                  3 = RS-485

                  4 = RS-422

[I] = Automatic repeat interval for Composite data message

  : 0 ... 3 600 s, 0 = no automatic repeat 

[B] = Baud rate: 1200, 2400, 4800, 9600, 19200, 38400,

             57600, 115200

[D] = Data bit: 7/8

[P] = Parity: O = Odd, E = Even, N = None

[S] = Stop bit: 1/2

[L] = RS-485 line delay: 0 ... 10 000 ms

[N] = Name of device: WXT520(read only)

[V] = Software version: for example, 1.00(read only)

<cr><lf>   Response terminator

표 1.2.1 WXT520, WXT536 Setting Fields
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1.2.2 Abbreviations and Units

Abbreviation Name Unit Status 1

Sn 풍속 최소 m/s, km/h, mph, knots #, M, K, S, N

Sm 풍속 평균 m/s, km/h, mph, knots #, M, K, S, N

Sx 풍속 최대 m/s, km/h, mph, knots #, M, K, S, N

Dn 풍향 최소 deg #, D

Dm 풍향 평균 deg #, D

Dx 풍향 최대 deg #, D

Pa 기압 hPa, Pa, bar, mmHg, inHg #, H, P, B, M, I

Ta 온도 ℃, ℉ #, C, F

Tp 내부온도 ℃, ℉ #, C, F

Ua 습도 %RH #, P

Rc 누적 강수량 mm, in #, M, I

Rd 강수량 지속 시간 s #, S

Ri 강수 강도 mm/h, in/h #, M, I

Rp 최대 강수 강도 mm/h, in/h #, M, I

Hc 누적 우박량 hits/㎠, hits/i , hit/h #, M, I, H

Hd 우박량 지속 시간 s #, S

Hi 우박 강도 hits/㎠h, hits//ih, hits/h #, M, I, H

Hp 최대 우박 강도 hits/㎠h, hits//ih, hits/h #, M, I, H

Th 히팅 온도 ℃, ℉ #, C, F

Vh 히팅 전압 V #, N, V, W, F

Vs 작동 전원 V V

Vr 3.5V 기준 전압 V V

Id 정보 alphanumeric

 

표 1.2.2 WXT520, WXT536 Abbreviations and Units

WXT536은 각 센서로부터 측정된 데이터를 수집하여, 사용자가 원하는 기상
정보를 제공하며, 시스템에 적용한 데이터의 항목 및 단위는 표 1.2.2 
WXT536 Abbreviations and Units의 빨간색으로 표시된 내용을 참고한다.

WXT536의 Status는 데이터 수집의 이상으로 인한 에러 시 데이터 단위에 #
으로 표출 된다.   
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1.2.3 Composite Data Message
Composite Data Message는 WXT536에 측정하는 풍향, 풍속, 온도, 습도, 기
압, 강수량의 모든 데이터를 설정된 시간에 따라 자동 전송한다. 

ex) 
0R0,Dn=230D,Dm=230D,Dx=230D,Sn=0.1M,Sm=0.1M,Sx=0.2M,Ta=10.8C,Tp=1
1.4C,Ua=39.9P,Pa=1004.2H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=11.2C,Vh=0.0N,Vs=14.1V,Vr=3.519V,Id=HEL/___

Composite Data Message는 설정된 센서의 수집 주기 및 전송 주기에 따라  
자동 전송되며, 데이터의 항목 및 단위는 표 1.2.2 WXT536 Abbreviations and 
Units의 빨간색으로 표시된 내용을 참고한다.

1.2.4 WXT536 Transmitter Setting Commands
WXT520의 설정은 명령어로도 인식이 가능하나 설정 부분은 Vaisala Configu 
ration Tool을 사용하여 설정변경을 권장한다.

     
1.2.5 Precipitation Counter Reset

Precipitation Counter Reset은 강수량 및 우박량의 누적 값을 리셋 하는 명령
어로서 리셋항목 및 방법은 다음과 같다.
리셋항목 : Rc = 누적 강수량
          Rd = 강수량 지속 시간
          Hc = 누적 우박량
          Hd = 우박량 지속 시간

ex) ASCII 통신체제: aXZRU<cr><lf>
a           = Device address: 0(default) ~ 9, A ~ Z, a ~ z
XZRU       = 강수량 및 누박량 누적 값 리셋 명령(ASCII, NMEA 0183)
<cr><lf>    = 명령어 종료시(ASCII, NMEA 0183)

0XZRU<cr><lf>
0TX,Rain reset<cr><lf>

1.2.6 Precipitation Intensity Reset
     Precipitation Intensity Reset은 강수량 및 우박량의 강도 값을 리셋 하는 명   
    령어로서 리셋항목 및 방법은 다음과 같다.

리셋항목 : Ri = 강수 강도
          Rp = 최대 강수 강도
          Hi = 누적 우박량
          Hp = 최대 우박 강도

ex) ASCII 통신체제: aXZRI<cr><lf>
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a           = Device address: 0(default) ~ 9, A ~ Z, a ~ z
XZRI       = 강수량 및 우박량의 강도 값 리셋 명령(ASCII, NMEA 0183)
<cr><lf>    = 명령어 종료시(ASCII, NMEA 0183)

0XZRI<cr><lf>
0TX,Inty reset<cr><lf>

1.2.5 WXT536 Software Reset
Software Reset 명령어를 이용한 리셋 방법은 다음과 같다.

ex) ASCII 통신체제: aXZ<cr><lf>
a           = Device address: 0(default) ~ 9, A ~ Z, a ~ z
XZ          = Reset 명령(ASCII, NMEA 0183)
<cr><lf>    = 명령어 종료시(ASCII, NMEA 0183)

  
     0XZ<cr><lf>

     0TX,Start-up<cr><lf>
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2. Vaisala Configuration Tool
WXT536은 유지보수 포트를 통하여 Vaisala Configuration Tool을 사용하여 
사용자 요구 사항에 맞게 설정 및 저장이 가능 하다. 현재 시스템에 구성될 
메시지 포맷은 Composite 메시지이며, 데이터 메시지에 대한 프로토콜은 
4.2.3 Composite Data Message를 참조 한다.

2.1 Vaisala Configuration Tool Install    
Vaisala Configuration Tool의 CD를 PC의 CD ROM에 삽입한다. 삽입 후  CD
드라이브의 폴더 내에 setup을 실행하면 프로그램 설치가 시작되며, 설치 순
서에 따라 진행한다. License number는 CD 케이스 뒷면을 참고하여, 설치순
서에 따라 프로그램 설치 및 USB드라이버를 설치한다.

그림 2.1.1 Vaisala Configuration Install 

그림 2.1.2 USB Driver Install 
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2.2 Vaisala Configuration Tool Setting for WXT536

2.2.1 Connection Setup  
프로그램 설치 완료 후 유지보수 케이블을 WXT536 하단의 4pin 커넥터에 연
결 후 PC의 USB포트와 연결 한다.

USB의 연결이 완료 되면 장치관리자의 포트를 확인하여, Visala USB 
Instrument의 포트 번호를 확인한다.

Vaisala Configuration Tool을 실행한다.
경로 : 시작 - 모든 프로그램 - Vaisala Configuration Tool - Vaisala          
        Configuration Tool 실행
        
        C:\Program Files\Vaisala Configuration Tool - WXTConf 실행

Vaisala Configuration Tool의 File -> Connection setup을 실행 시킨 후 통   
신 설정을 한다. 
 - Baud rate : 19200
 - Data bit : 8
 - Parity : None
 - Stop bit : 1
 - Flow control : None
Vaisala Configuration Tool을 사용하기 위해서는 ASCII, automatic 통신 프로
토콜을 사용하여야한다

그림 2.2.1 Connection Setup
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2.2.2 Profile Manager 
 Vaisala Configuration Tool의 File -> Profile Manager를 실행 시킨 후 Read  
 from Device를 실행하면 현재 WXT536의 설정값을 보여주며, 모든 설정이   
 완료 된 후  파일을 저장하여 설정값을 저장하여 관리 할 수 있다.

그림 2.2.2 Profile Manager

 - Save As : Profile file(.wxc) 파일 저장
 - Delete : Profile file(.wxc) 삭제
 - Clear : WXT536 settings 취소
 - Read from Device : WXT536 현재 설정 파일 불러오기
 - Write to Device : WXT536 Profile 변경 및 저장
 - Change folder : Profile file(.wxc) 저장 경로 변경
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2.2.3 Factory Manager 
Vaisala Configuration Tool의 File -> Factory Manager를 실행 시킨 후 Read  
from Device를 실행하면 현재 WXT536의 시리얼번호 및 교정값을 보여주며, 
저장이 가능하다. 

그림 2.2.3 Factory Manager

 - Save : Factory file(.wxf) 파일 저장
 - Read from Device : WXT536 현재 설정 파일 불러오기
 - Change folder : Factory file(.wxf) 저장 경로 변경
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2.2.4 View 
Vaisala Configuration Tool의 View -> Wind, PTU, Precipitation, Timing 
Control, Composite Message를 활성화하면 WXT536의 데이터를 확인 할 수 
있다.

그림 2.2.4 View
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2.2.5 Device Sttings
Vaisala Configuration Tool의 Setting -> Device Settings를 클릭하면 
WXT536의 설정 값을 변경 할 수 있다. 설정 완료 후 OK를 클릭하여 설정을 
저장한다. 

그림 2.2.5 Device Settings

 Device
 - WXT536의 모델명, 각 파트별 센서 정보를 제공한다.
   설정값 : Default 사용 변경사항 없음.   
 Enhancements
 - Heating, Error Messaging, Composite message auto transmission의 사용  
   여부를 설정 할 수 있다.
   설정값 : Enable Heating - 활성화
           Error Messaging - 활성화 15S 변경
           Composite message auto transmission - 활성화 및 3S 변경
 Communication protocol
 - 통신 프로토콜에 관련된 데이터 포맷을 변경할 수 있다.
   설정값 : ASCII auto - 활성화
 User port setting
 - 통신에 관련된 설정을 변경 할 수 있다.
   설정값 : Port type - RS485
           Communication Setting - 19200, 8, None, 1
           RS-485 line delay(ms) - 25
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2.2.6 Sensor Sttings 
Vaisala Configuration Tool의 Setting -> Sensor Settings를 클릭하면 
WXT536의 각 센서의 설정 값을 변경 할 수 있다. 설정 완료 후 OK를 클릭하
여 설정을 저장한다. 

그림 2.2.6 Sensor Settings
 
 Wind
 - Wind Sensor의 설정값을 변경할 수 있다.
   설정값 : Gust averaging - 3 및 0으로 변경 설정
           Speed unit - m/s 및 3S으로 변경 설정
           Sampling frequency - 4Hz 및 1S으로 변경 설정
 PTU
 - PTU Sensor의 설정값을 변경할 수 있다.
   설정값 : Temperature unit - Celsius 및 1mim 으로 변경 설정
           Barometric pressure unit - hPa 및 1min으로 변경 설정

 Precipitation
 - Precipitation Sensor의 설정값을 변경할 수 있다.
   설정값 : Counter reset - Manual
           Rain unit - Metric
           Hail unit - Metric
           Auto report based on - Time
           Auto report interval - 1min으로 변경 설정
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2.2.7 Message Sttings 
Vaisala Configuration Tool의 Setting -> Message Settings를 클릭하면 
WXT536의 메세지 설정 값을 변경 할 수 있다. 설정 완료 후 OK를 클릭하여 
설정을 저장한다. 

그림 2.2.7 Message Settings

Composite Message
 - WXT520, WXT536의 각 데이터 항목을 선택 및 설정 내용을 변경할 수 있  
   다.
   설정값 : Composite Message - 메시지 전 항목 활성화

2.2.8 Test Monitor
Vaisala Configuration Tool의 Setting -> Test Monitor를 클릭하면 WXT536의 
메세지 작동중인 WXT536의 정보를 확인 할 수 있다.

그림 2.2.8 Test Monitor
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3. Troubleshooting
Wind Sensor Errors

문제점

풍향, 풍속 데이터 측정 오류

풍향, 풍속 데이터 이상 및 #으로 표시

ex) 

0R0,Dn=000#,Dm=000#,Dx=000#,Sn=0.0#,Sm=0.0#,Sx=0.0#,Ta=2

1.3C,Tp=22.0C,Ua=17.6P,Pa=1017.9H,Rc=0.00M,Rd=0s,Ri=0.0M,H

c=0.0M,Hd=0s,Hi=0.0M,Rp=0.0M,Hp=0.0M,Th=21.4C,Vh=0.0N,Vs

=14.1V,Vr=3.528V,Id=Hel

원인
1) Wind transducers의 오류(이물질, 낙엽, 새, 눈, 얼음 등)

2) 터미널프로그램의 설정 오류(<cr><lf>)

조치사항

1) Wind transducers의 이물질 제거 및 손상여부 육안으로 확인.

   Wind transducers 사이를 막고 있는 얼음이나 눈에 의해 발 

   생한 것이라면, 히터가 작동하나 설치환경에 따라 시간이 지 

   연될 수 있다.

2) ASCII 프로토콜은 각 명령어 끝에 <cr><lf>에 필요하며, 터미 

  널프로그램 또는 제어기에서 정상적으로 입력되는지를 확인 

  한다.

PTU Sensor Errors

문제점

온도, 습도, 기압 데이터 측정 오류

온도, 습도, 기압 이상 및 #으로 표시

ex) 

0R0,Dn=045D,Dm=045D,Dx=045D,Sn=0.0M,Sm=0.0M,Sx=0.1M,Ta

=99.1#,Tp=80.0#,Ua=102.0#,Pa=1500.0#,Rc=0.00M,Rd=0s,Ri=0.0

M,Hc=0.0M,Hd=0s,Hi=0.0M,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0

N,Vs=14.1V,Vr=3.530V,Id=Hel

원인
1) PTU 모듈이 연결되지 않음으로 인한 오류  

2) PTU 모듈이 젖어 발생되는 오류

조치사항

1) PTU 모듈의 연결 상태 확인 및 WXT520, WXT536과 취부 상 

   태 확인 한다.

2) WXT536에서 PTU 모듈을 제거 후 젖어 있는 필터를 말리고, 

   재 연결 하여 데이터를 확인 한다.
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Communication Errors

문제점

명령어가 실행되지 않음

Vaisala Configuration Tool의 데이터 미표출 및 설정기능이 작동 

되지 않음

원인

1) 결선상의 잘못된 부분으로 인한 오류

  공급 전원이 연될 되지 않아 발생하는 오류

2) 장비와 호스트 사이의 통신설정 오류

조치사항

1) 결선 및 공급전원을 확인 한다. 

2) 유지보수 케이블을 이용하여 aXU<cr><lf> 명령어를 이용하여 

  통신 설정을 확인 한다. 
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4. Appendix
4.1 Data Protocol

WXT536의 데이터 메시지는 Composit Message를 사용하며, 3초 간격으로 자
동 전송 한다. Precipitation Data는 리셋 명령어를 이용하여 누적량에 대한 
값을 리셋 하여 사용하여야 한다. 상세 사항은 4. Communication Protocol를 
참고 한다.
 

     ex)
0R0,Dn=082D,Dm=082D,Dx=082D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.7P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0N,Vs=14.1V,Vr=3.530V,Id=Hel
0R0,Dn=084D,Dm=084D,Dx=084D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0N,Vs=14.1V,Vr=3.530V,Id=Hel
0R0,Dn=068D,Dm=068D,Dx=068D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.2C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0N,Vs=14.1V,Vr=3.530V,Id=Hel
0R0,Dn=089D,Dm=089D,Dx=089D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0N,Vs=14.1V,Vr=3.530V,Id=Hel
0R0,Dn=129D,Dm=129D,Dx=129D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.2C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.6C,Vh=0.0N,Vs=14.1V,Vr=3.530V,Id=Hel
0R0,Dn=110D,Dm=110D,Dx=110D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.4C,Vh=0.0N,Vs=14.0V,Vr=3.530V,Id=Hel
0R0,Dn=036D,Dm=036D,Dx=036D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.4C,Vh=0.0N,Vs=14.0V,Vr=3.530V,Id=Hel
0R0,Dn=342D,Dm=342D,Dx=342D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.4C,Vh=0.0N,Vs=14.0V,Vr=3.530V,Id=Hel
0R0,Dn=027D,Dm=027D,Dx=027D,Sn=0.0M,Sm=0.1M,Sx=0.1M,Ta=20.1C,Tp=2
1.0C,Ua=16.8P,Pa=1018.3H,Rc=0.00M,Rd=0s,Ri=0.0M,Hc=0.0M,Hd=0s,Hi=0.0M
,Rp=0.0M,Hp=0.0M,Th=20.4C,Vh=0.0N,Vs=14.0V,Vr=3.530V,Id=Hel
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5. MCC201 Setup
    MCC201은 WXT536의 모니터링 및 저장을 하는 소프트웨어로서 Real-Time    
     Display, Data Archiving and Viewing (ASCII Log View), Terminal Software    
     (IO Terminal)의 기능으로 구성되어 있으며, 월간 간격으로 파일을 덮어쓰기   
     함으로 주기적으로 백업이 필요하다. 

5.1 MCC201 Install
MCC201의 CD를 PC의 CD ROM에 삽입한다. 삽입 후 CD드라이브의 win32폴
더 내에 MCC201-1.0.0.4를 실행시키고 순차적으로 소프트웨어를 설치한다.

그림 5.1 MCC201 Install
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그림 5.1 MCC201 Install
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5.2 Weather
     MCC201의 Weather는 WXT536의 실시간 데이터를 모니터링 할 수 있다. 풍향  
     풍속은 3초, 온도 습도 기압 강수는 1분 값을 사용한다. 시간은 UTC로 표기되  
     며, Day/night 사용하면 화면을 밝게 또는 어둡게 사용가능하다. 

그림 5.2 Weather
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5.3 Log
      MCC201의 Log는 WXT536의 저장된 데이터 및 로그를 뷰어를 통해 조회, 저  
      장, 프린터를 할 수 있다. Log 파일은 SYSTEM_EVENTS, WXT520_DATA,      
      WXT520_MESSAGES, WXT520_STATUS로 구분되며 01부터 31번 파일로 구성  
      되어 월간 단위로 덮어쓰기 된다. 따라서 2주 주기또는 월말 단위로 데이터  
      를 백업하여 보관하여야 한다.        
      

그림 5.3 Log
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5.4 Settings - Communication
     Setting Communication은 WXT536과의 Sensor data connection, FTP,        
     Terminal등 통신에 관련된 설정을 변경 및 저장할 수 있다. 변경 후 Apply를  
     클릭하여 변경된 설정을 적용한다.
     
TCP/IP 사용시 설정 방법
Sensor data connection : Communication -> TCP client to main PC로 변경
                        Sensor mode -> Autosend 로 변경
                        TCP/IP Client -> 192.168.82.34:1470 IP 및 port 변경
                        Precipitation Accumulation reset
                      Reset status -> Enabled로 변경
                      Reset hour -> 13UTC 리셋할 UTC시간으로 변경 
                      
모든 설정 완료 후 시작 - 모든프로그램 - Vaisala - MCC201 - Stop 프로세서 정
지 후 시작 - 모든프로그램 - Vaisala - MCC201 - Start를 실행하여 프로세서를 재
시작한다. 

주의: 프로세서를 재시작 하지 않을 경우 정상적으로 작동이 안됨.

그림 5.4.1 Settings Communication
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RS232 사용시 설정 방법
Sensor data connection : Communication -> serial for sensor로 변경
                        Sensor mode -> Autosend 로 변경
                        Serial setting
                        Com port -> COM1 PC에 연결된 Com port로 설정
                        Baud rate -> 19200
                        Dara bit -> 8
                        Parity -> None
                        Stop bits -> 1                        
                        Precipitation Accumulation reset
                      Reset status -> Enabled로 변경
                      Reset hour -> 13UTC 리셋할 UTC시간으로 변경 
                      
모든 설정 완료 후 시작 - 모든프로그램 - Vaisala - MCC201 - Stop 프로세서 정
지 후 시작 - 모든프로그램 - Vaisala - MCC201 - Start를 실행하여 프로세서를 재
시작한다. 

주의: 프로세서를 재시작 하지 않을 경우 정상적으로 작동이 안됨.

그림 5.4.2 Settings Communication
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5.5 Settings - Operation
     Setting Operation은 각 측정항목의 Unit, Location, Parameter Alert Limits을  
     설정할 수 있으며, 운영자의 지침에 맞게 변경 후 Apply를 클릭하여 설정 내  
     용을 저장한다. 

그림 5.5 Settings Operation


